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Schema Compare for Oracle enables you to compare and deploy Oracle database 

schemas. 

This is useful, for example, in a development environment when you need to transfer 

changes made to a local database to a live database on a remote server. Traditionally, 

this meant spending hours scrutinizing the database structure and hand-generating 

migration scripts. Schema Compare for Oracle automates this process for you. 

You can use Schema Compare for Oracle to compare and deploy Oracle Database 9i, 10g 

and 11g databases. 

Requirements 

The following are required to use Schema Compare for Oracle: 

 Windows XP, Windows Server 2003, Windows Server 2008, Windows Vista®, or 

Windows 7. 

 Microsoft .NET Framework version 4.0 or later. 

You can download the 32-bit framework 

(http://www.microsoft.com/downloads/details.aspx?displaylang=en&amp;FamilyID=0

856eacb-4362-4b0d-8edd-aab15c5e04f5), or the x64 framework 

(http://www.microsoft.com/downloads/details.aspx?familyid=B44A0000-ACF8-4FA1-

AFFB-40E78D788B00&amp;displaylang=en). 

Schema Compare for Oracle: step-by-step 

1. Choose the schemas to compare (page 17). 

2. View the comparison results (page 30). 

3. Set up the deploymen (page 37)t. 

4. Create a deployment script (page 40). 

Worked example 

Learn more about Schema Compare for Oracle by following this detailed example: 

 Comparing and deploying database schemas (page 4). 
 

Getting started 

http://www.microsoft.com/downloads/details.aspx?displaylang=en&amp;FamilyID=0856eacb-4362-4b0d-8edd-aab15c5e04f5
http://www.microsoft.com/downloads/details.aspx?displaylang=en&amp;FamilyID=0856eacb-4362-4b0d-8edd-aab15c5e04f5
http://www.microsoft.com/downloads/details.aspx?familyid=B44A0000-ACF8-4FA1-AFFB-40E78D788B00&amp;displaylang=en
http://www.microsoft.com/downloads/details.aspx?familyid=B44A0000-ACF8-4FA1-AFFB-40E78D788B00&amp;displaylang=en


 

© Red Gate Software Ltd  4 

4 June 2013 

 

This worked example demonstrates a basic comparison and deployment of two schemas 

in an Oracle database. 

In the example, The Wooly Widget Company has an Oracle database running on a live 

web server. This database contains many tables, views, indexes, packages, and other 

objects. The Wooly Widget Company's development team have been working on an 

upgrade to to their website. As part of this upgrade, they have made a number of 

changes to the structure of the development schema. They need to transfer the changes 

from the development schema to the test schema. This worked example uses Schema 

Compare for Oracle to transfer these changes. 

The example has four steps: 

1. Set up the schemas (page 4). 

Create the example database schemas on your Oracle server. 

2. Set up the comparison (page 4). 

Specify the schemas you want to compare. 

3. Select objects to deployment (page 6). 

Review the comparison results and select the objects you want to deployment. 

4. Deploy the schemas (page 8). 

Create and run a deployment script. 
 

1. Set up the schemas 

The worked example uses the WIDGETDEV and WIDGETTEST schemas: 

 WIDGETDEV is the development schema 

 WIDGETTEST is the test schema 

To create the schemas on your Oracle server: 

1. Click here to view the SQL creation script 

(/support/Schema_Compare_for_Oracle/help/1.0/WidgetDatabases.sql) for the 

schemas. 

2. Copy this script, paste it into your SQL editor, and run it on any database you choose. 

The schemas are created. 
 

2. Set up the comparison 

1. Start Schema Compare for Oracle if it is not already running.  

Worked example: Comparing and deploying databases 

/support/Schema_Compare_for_Oracle/help/1.0/WidgetDatabases.sql
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The Project Configuration dialog box is displayed showing your most recent project: 

 

In this example, we will create a new project. 

2. Click Cancel to close the dialog box. 

3. On the toolbar, click  New Project. 

A new Project Configuration dialog box is displayed. 

4. In the shaded upper pane, ensure both Source and Target are set to Database. 

In this example, we are comparing schemas from a live database; you can also 

compare schemas from saved snapshots. 

5. Select a connection method to connect to the database on which you set up the 

schemas: 

 If you want to connect using aliases in your tnsnames.ora configuration file, under 

Source, select the TNS Connection tab. 

 If you do not not have Oracle client software installed, or cannot use a 

tnsnames.ora file, select the Manual Connection tab. 

6. Enter connection details for the database on which you set up the schemas. 

7. In the User name box, type WIDGETDEV, and in the Password box, type password. 

8. To set the target database to the same as the source, click . 
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The connection details you entered for the source database are automatically entered 

for the target. 

9. Under Target, in the User name box, type WIDGETTEST, and in the Password box, 

type password. 

10. Under Source, in the Schemas box, select the WIDGETDEV schema.  

11. Under Target, in the Schemas box, select the WIDGETTEST schema.  

In this example, we are comparing only one source schema and one target schema. 

Schema Compare for Oracle allows you to compare as many schemas as you like. For 

more information, see Selecting schemas to compare 

(/supportcenter/Content.aspx?p=Schema Compare for 

Oracle&amp;c=Schema_Compare_for_Oracle/help/1.0/sco_setting_data_sources.htm

&amp;toc=Schema_Compare_for_Oracle/help/1.0/toc1098210.htm#o10986). 

12. Click Compare Now. 

Schema Compare for Oracle displays a message dialog box that shows the progress of 

the comparison. 

13. When the comparison is complete, to close the message box, click OK. 
 

3. Select objects to deployment 

The results of the comparison are displayed: 

 

The results are grouped by: 

 
objects that exist in both databases but are different 

/supportcenter/Content.aspx?p=Schema%20Compare%20for%20Oracle&amp;c=Schema_Compare_for_Oracle/help/1.0/sco_setting_data_sources.htm&amp;toc=Schema_Compare_for_Oracle/help/1.0/toc1098210.htm#o10986
/supportcenter/Content.aspx?p=Schema%20Compare%20for%20Oracle&amp;c=Schema_Compare_for_Oracle/help/1.0/sco_setting_data_sources.htm&amp;toc=Schema_Compare_for_Oracle/help/1.0/toc1098210.htm#o10986
/supportcenter/Content.aspx?p=Schema%20Compare%20for%20Oracle&amp;c=Schema_Compare_for_Oracle/help/1.0/sco_setting_data_sources.htm&amp;toc=Schema_Compare_for_Oracle/help/1.0/toc1098210.htm#o10986
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objects that exist in WIDGETDEV but do not exist in 

WIDGETTEST 

 
objects that exist in both databases and are identical 

To view the objects in a group, click : 

 

To display a side-by-side, color-coded listing of the differences in the object creation 

scripts, click an object in the upper pane. The SQL Differences pane is displayed. This 

example shows the WIDGETPRICES table: 

 

For more information, see: 

 Viewing the comparison results (page 30) 

 Viewing the SQL differences (page 34) 

To select objects for deployment, use the check boxes in the middle of the results. 

In this example, we will deployment all objects that are different: 

1. To the left-hand side of the comparison results, in the Filter pane, ensure the default 

filter All object types included is selected. 

The filter defines which objects are displayed. When you use the filter to exclude an 

object, it is removed from the Results pane and cannot be selected for deployment. 

For more information, see Using the filter (/supportcenter/Content.aspx?p=Schema 

Compare for 

/supportcenter/Content.aspx?p=Schema%20Compare%20for%20Oracle&amp;c=Schema_Compare_for_Oracle/help/1.0/sco_viewing_comparison_results.htm&amp;toc=Schema_Compare_for_Oracle/help/1.0/toc1098219.htm#o9487
/supportcenter/Content.aspx?p=Schema%20Compare%20for%20Oracle&amp;c=Schema_Compare_for_Oracle/help/1.0/sco_viewing_comparison_results.htm&amp;toc=Schema_Compare_for_Oracle/help/1.0/toc1098219.htm#o9487
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Oracle&amp;c=Schema_Compare_for_Oracle/help/1.0/sco_viewing_comparison_resul

ts.htm&amp;toc=Schema_Compare_for_Oracle/help/1.0/toc1098219.htm#o9487). 

2. To select all objects for deployment, in the central column of the Results pane, select 

the top level check box: 

 

All objects are selected, and the  Deployment Wizard button becomes available. 

3. Click  Deployment Wizard. 
 

4. Synchronize the schemas 

The Synchronization wizard creates the SQL script to make the objects you selected 

(page 6) in the comparison results identical. 

On the first page of the wizard you can choose to create and save a synchronization 

script, or perform the synchronization using Schema Compare for Oracle. 

/supportcenter/Content.aspx?p=Schema%20Compare%20for%20Oracle&amp;c=Schema_Compare_for_Oracle/help/1.0/sco_viewing_comparison_results.htm&amp;toc=Schema_Compare_for_Oracle/help/1.0/toc1098219.htm#o9487
/supportcenter/Content.aspx?p=Schema%20Compare%20for%20Oracle&amp;c=Schema_Compare_for_Oracle/help/1.0/sco_viewing_comparison_results.htm&amp;toc=Schema_Compare_for_Oracle/help/1.0/toc1098219.htm#o9487
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Choose synchronization method 

In this example, we will synchronize using Schema Compare for Oracle: 

 

1. On the left side of the wizard, select Synchronize using Schema Compare for 

Oracle, if is not already selected. 

2. Clear the Create snapshot of target before synchronization check box.  

In this example, we will not create a snapshot before we synchronize. 

3. Ensure the Recompare after synchronization and the Save copy of the 

synchronization script check boxes are selected. 

In this example, we will run the script from Schema Compare for Oracle, and compare 

the databases afterwards to see that the synchronization has been successful. We will 

also save a copy of the synchronization script. 

4. Click Next. 
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Review dependencies 

The Review dependencies page of the wizard lists any objects that you did not select 

for synchronization that reference, or are referenced by, objects you did select for 

synchronization: 

 

All the objects you selected for synchronization are listed in the left-hand pane, and any 

affected objects are listed in the right hand pane. For more information, see Review 

dependencies (/supportcenter/Content.aspx?p=Schema Compare for 

Oracle&amp;c=Schema_Compare_for_Oracle/help/1.0/sco_using_the_synchronization_wi

zard.htm&amp;toc=Schema_Compare_for_Oracle/help/1.0/toc1098225.htm#o9527). 

In this example there are no affected objects. 

/supportcenter/Content.aspx?p=Schema%20Compare%20for%20Oracle&amp;c=Schema_Compare_for_Oracle/help/1.0/sco_using_the_synchronization_wizard.htm&amp;toc=Schema_Compare_for_Oracle/help/1.0/toc1098225.htm#o9527
/supportcenter/Content.aspx?p=Schema%20Compare%20for%20Oracle&amp;c=Schema_Compare_for_Oracle/help/1.0/sco_using_the_synchronization_wizard.htm&amp;toc=Schema_Compare_for_Oracle/help/1.0/toc1098225.htm#o9527
/supportcenter/Content.aspx?p=Schema%20Compare%20for%20Oracle&amp;c=Schema_Compare_for_Oracle/help/1.0/sco_using_the_synchronization_wizard.htm&amp;toc=Schema_Compare_for_Oracle/help/1.0/toc1098225.htm#o9527
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Review script 

The final page of the wizard displays information about the synchronization: 

 

There are three tabs on the Review script page: 

 Synchronization script displays the script Schema Compare for Oracle has created 

to synchronize the data sources. 

You can search the script, save it, or copy it to the clipboard. 

 Summary displays a synopsis of the actions in the synchronization script. 

You can view the summary grouped by the objects affected, by the type of 

modification, or by the order in which the script modifies the target. 

 Warnings displays a list of any warnings about unexpected behavior that may occur 

when you synchronize the databases.  

In this example there are no warnings. 

Performing the synchronization 

When you have reviewed the script, synchronize the schemas: 

1. Click Synchronize Now. 

2. A confirmation dialog box is displayed; to continue, click Synchronize Now. 

3. Schema Compare for Oracle displays a message dialog box that shows the progress of 

the synchronization.  

When the synchronization is complete, click OK to close the message box. 
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Schema Compare for Oracle then re-compares the databases. The results are shown in 

the main window. In this example, all objects are shown to be identical, confirming that 

the synchronization has been a success: 
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You can launch Schema Compare for Oracle directly from Oracle SQL Developer using the 

Schema Compare for Oracle extension. 

To install the extension: 

1. In Oracle SQL Developer, on the Help menu, click Check for Updates. 

 

2. On the Welcome page of the Check for Updates wizard, click Next. 

3. On the Source page of the wizard, ensure that the Third Party SQL Developer 

Extensions check box is selected, and click Next. 

 

4. Select the Schema Compare for Oracle check box, and click Finish. 

The Schema Compare for Oracle extension is installed. Note that you must restart 

Oracle SQL Developer to use the extension. 

Using the Oracle SQL Developer extension 
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To launch Schema Compare for Oracle using the extension: 

1. On the Oracle SQL Developer menu bar, click . 

2. If Schema Compare for Oracle is already installed on your computer, select Use an 

existing installation of product, browse to the location where you installed Schema 

Compare for Oracle, and select RedGate.Oracle.Compare.UI.exe. 

If you have not installed Schema Compare for Oracle, select Install Schema 

Compare for Oracle. 

3. Click OK. 

If you selected to install Schema Compare for Oracle, the installer runs. Follow the 

instructions to install Schema Compare for Oracle on your computer.  

4. Restart Oracle SQL Developer. 

5. On the Oracle SQL Developer menu bar, click . 

 

 
 



 

© Red Gate Software Ltd  15 

4 June 2013 

 

Whenever you compare database schemas, you set up a project. If you have any existing 

projects, the Project Configuration dialog box for your most recently used project is 

displayed when you start Schema Compare for Oracle. 

A project contains details of: 

 which data sources (page 17) you selected 

 the connection details for your data sources 

 which schemas you selected to compare 

 which project configuration options (page 26) you selected 

 which objects you have selected for deployment (page 37) 

 your filter (/supportcenter/Content.aspx?p=Schema Compare for 

Oracle&amp;c=Schema_Compare_for_Oracle/help/1.0/sco_viewing_comparison_resul

ts.htm&amp;toc=Schema_Compare_for_Oracle/help/1.0/toc1098219.htm#o9487) 

settings 

Finding a project 

On the toolbar, click  to display the Open Project browser: 

 

The browser allows you to locate and open saved project files on your computer. 

Working with projects 

/supportcenter/Content.aspx?p=Schema%20Compare%20for%20Oracle&amp;c=Schema_Compare_for_Oracle/help/1.0/sco_viewing_comparison_results.htm&amp;toc=Schema_Compare_for_Oracle/help/1.0/toc1098219.htm#o9487
/supportcenter/Content.aspx?p=Schema%20Compare%20for%20Oracle&amp;c=Schema_Compare_for_Oracle/help/1.0/sco_viewing_comparison_results.htm&amp;toc=Schema_Compare_for_Oracle/help/1.0/toc1098219.htm#o9487
/supportcenter/Content.aspx?p=Schema%20Compare%20for%20Oracle&amp;c=Schema_Compare_for_Oracle/help/1.0/sco_viewing_comparison_results.htm&amp;toc=Schema_Compare_for_Oracle/help/1.0/toc1098219.htm#o9487
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By default, Schema Compare for Oracle project files are saved in: 

%ALLUSERSPROFILE%\My Documents\Schema Compare for Oracle\Projects 

Project files are saved with the extension .ocp 

Creating and saving a project 

To create a new project, on the toolbar, click  New. 

To save a project, on the toolbar, click  Save. Alternatively, on the Project 

Configuration dialog box, click Save.  

You can also save a project when you are reviewing its comparison results (page 30). 

This can be useful if you want to save your object selections with the project. 

If there are unsaved changes in the current project, you will be prompted to save when 

you create a new project, open another project, or when you close Schema Compare for 

Oracle. 
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When you create a new project, Schema Compare for Oracle requires information about 

which two data sources you want to compare, and how to connect to them.  

This topic describes how to connect to data sources in Schema Compare for Oracle. 

Selecting data sources (page 17) 

Using a TNS connection (page 18) 

Using a manual connection (page 18) 

Selecting a snapshot (page 19) 

Selecting schemas to compare (page 19) 

Using a direct connection (page 20) 

 
 

Selecting data sources 

You enter information about the data sources you want to compare on the Project 

Configuration dialog box. 

 

Setting data sources 
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Specify the two data sources you want to compare in the Data Sources tab. You specify 

a source and a target. The source is the data source that will not change; the target is 

the data source that will change. 

To switch the source and target, click . 

You can compare the following types of data source: 

 Database 

A database on an Oracle server that you can connect to.  

You will need to enter connection details. You can connect to an Oracle database 

using a TNS connection (page 18) or a manual connection (page 18).  

 Snapshot 

A file created by Schema Compare for Oracle that contains information about the 

structure of database schemas. 

If you select a snapshot as the target, the snapshot file will not be modified. Instead, 

a deployment script is generated to modify the database from which the snapshot was 

made. 

You can compare any combination of data source types in your project. 
 

Using a TNS connection 

A TNS connection enables you to connect to a database using an alias specified in your 

tnsnames.ora configuration file. 

By default, tnsnames.ora is located in:  

ORACLE_HOME/network/admin 

To connect using a TNS connection: 

1. Under Source or Target, select Database. 

2. Select the TNS Connection tab, if it is not already selected. 

3. In the Oracle home box, type or select the name of the Oracle home. 

An Oracle home is the location of an Oracle Database installation. 

4. Under Database, in the Network Alias box, type or select the alias (network service 

name) of the database and then enter the User name and Password. 

If you want Schema Compare for Oracle to remember your password, select the Save 

check box. 

5. In the Connect as box, select the privileges you want to connect with. 
 

Using a manual connection 

A manual connection can be useful if: 
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 you do not not have Oracle client software installed, and cannot use a tnsnames.ora 
file 

 you do not have an alias entry for a database you want to compare in your 

tnsnames.ora file 

 you are experiencing problems connecting to a database using a TNS connection 

 you want to connect to a database without an Oracle client installed, using a direct 

connection (page 20) 

To connect using a manual connection: 

1. Under Source or Target, select Database as the data source. 

2. Select the Manual Connection tab. 

3. In the Host name box, type the host system name for the database . 

A host system name can be: 

 an IP address 

 a computer name 

 localhost, if you connect to a database that is on the same computer as Schema 

Compare for Oracle 

4. In the Port box, type the listener port number. 

5. From the Database menu, select SID or Service name. 

A SID (system identifier) is a unique name for an Oracle database on a specific host; 

a service name is an alias for a database specified in your tnsnames.ora configuration 

file. 

6. Type the SID or service name as appropriate, and enter the User Name and 

Password. 

If you want Schema Compare for Oracle to remember your password, select the Save 

check box. 

7. In the Connect as box, select the privileges you want to connect with. 
 

Selecting a snapshot 

1. Under Source or Target, select Snapshot. 

2. In the Snapshot box, type the file path of a saved snapshot file or click  to 

browse to a snapshot file. 

Schema Compare for Oracle displays information about the database from which the 

snapshot was created. 
 

Selecting schemas to compare 

When you have specified source and target data sources, you can select the schemas to 

compare. You can compare a single schema from each data source, or multiple schemas. 

To compare a single schema from each data source: 
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1. Under Source, in the Schemas box, type or select a schema. 

If a schema with the same name exists in the target data source, it is automatically 

selected. 

2. If you want to compare to a different schema, under Target, select the required 

schema. 

If no schemas are displayed in Schemas, click Refresh list. 

Note that if you are using a snapshot, you can only select from the schemas that were 

included when the snapshot was created. 

To compare multiple schemas from each data source: 

1. In the Schemas boxes, select a source and a target schema to compare. 

2. Click +Add schemas to the comparison. 

 

The schemas you selected are added to the comparison, and displayed in the lower 

pane. 

 

3. Repeat this process for as many schemas as you want to compare. 

Note that the schemas selected in the Schemas boxes and the schemas in the lower 

pane are all compared when you run the comparison. 

If you want to remove schemas that you have added to the comparison, click x Remove. 
 

Using a direct connection 

You can choose to connect to a database directly over TCP/IP when you are using a 

manual connection (page 18). 
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A direct connection does not require an Oracle client, and can be useful if you are 

experiencing problems connecting to databases. 

To use a direct connection: 

1. On the Tools menu, click Application Options. 

2. Under Connections, select the Use direct connection check box. 

 

3. Click OK. 

You can now use a manual connection (page 18) to connect to a database directly. 

Note that if you use a direct connection, you cannot use a service name to connect to a 

database. 
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A snapshot is a compressed XML file containing information about the structure of one or 

more database schemas.  

You can use snapshots to save the structure of schemas at a specific point in time. You 

can then compare a live database with a saved snapshot to see what changes have been 

made. Any changes can then be restored by using the snapshot as the source for 

deployment. 

Note that snapshots do not contain any table data.  

You can create a snapshot of: 

 the target schemas before you deploy them 

 the source or target schema(s) that you have compared 

 schemas from a selected database 

Creating a snapshot of the target schemas before deployment 

In the Deployment Wizard (page 40), you have the option to automatically create a 

snapshot of the target schemas you selected for comparison, before you deploy them. 

On the Choose deployment method page of the Deployment Wizard, select the Create 

snapshot of target before deployment check box, and enter a name and location for 

the snapshot: 

 

Creating a snapshot of the source or target schema(s) you have 
compared 

To create a snapshot of the schemas you selected for comparison in the source or target 

data source: 

1. Select the data sources (page 17) to compare, and run the comparison. 

The comparison results are displayed. 

Working with snapshots 
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2. On the File menu, click either Create Snapshot of Source or Create Snapshot of 

Target. 

The Create Snapshot dialog box is displayed: 

 

3. Specify a name and location for the snapshot, and click Create Snapshot. 

Note that: 

 you can create a snapshot of the source or target schemas only when you have run 
the comparison 

 you cannot select individual objects to include in the snapshot; all objects in the 

schema(s) you selected for comparison are included 

 if ghost objects 

(/supportcenter/Content.aspx?p=Schema%20Compare%20for%20Oracle&amp;c=Sch

ema_Compare_for_Oracle/help/0.1Early_Access/scoEAP_dependencies.htm&amp;toc

=Schema_Compare_for_Oracle/help/0.1Early_Access/toc.htm#o9695) are included in 
the comparison, they will be included in the snapshot 

 

Creating a snapshot of schemas from a selected database 

To create a snapshot of schemas from a selected database without running a comparison: 

1. On the File menu, click Create Snapshot.  

/supportcenter/Content.aspx?p=Schema%20Compare%20for%20Oracle&amp;c=Schema_Compare_for_Oracle/help/0.1Early_Access/scoEAP_dependencies.htm&amp;toc=Schema_Compare_for_Oracle/help/0.1Early_Access/toc.htm#o9695
/supportcenter/Content.aspx?p=Schema%20Compare%20for%20Oracle&amp;c=Schema_Compare_for_Oracle/help/0.1Early_Access/scoEAP_dependencies.htm&amp;toc=Schema_Compare_for_Oracle/help/0.1Early_Access/toc.htm#o9695
/supportcenter/Content.aspx?p=Schema%20Compare%20for%20Oracle&amp;c=Schema_Compare_for_Oracle/help/0.1Early_Access/scoEAP_dependencies.htm&amp;toc=Schema_Compare_for_Oracle/help/0.1Early_Access/toc.htm#o9695
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The Create Snapshot dialog box is displayed: 

 

2. Under Data source details, enter connection details for the database you want to 

create the snapshot from. 

For information about connecting to databases, see Setting data sources (page 17). 

3. Under Schemas, click Refresh Schemas to display the list of schemas in the 

database. 

4. Select schemas to include in the snapshot by selecting the check box next to each 

schema. 

5. Specify a name and location for the snapshot, and click Create Snapshot. 
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Deploying snapshots 

When a snapshot is the source data source and a database is the target data source, 

deploying updates the database to deploy it to the snapshot. 

When a snapshot is the target data source, deploying creates a script to update the 

database from which the snapshot was created. Note that snapshots cannot be modified 

directly. 
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Project options enable you to modify the comparison and deployment behavior of Schema 

Compare for Oracle.  

For example, you can set a project option so that when you run a comparison, certain 

differences between two objects are ignored. 

To set project options: 

1. Open the Project Configuration dialog box if it is not displayed. 

 If you want to set options for a new project, on the toolbar, click  New 

 If you want to set options for a saved project, on the toolbar, click  Open, 
select a project, and click Open  

 If you are reviewing comparison results for an open project, on the toolbar, click 

 Edit Project 

1. On the Project Configuration dialog box, click the Options tab. 

The list of available options is displayed: 

 

2. For each option you want to set, select its check box. 

To search for an option, type search text in the Find box. The list of options is filtered to 

display only options that contain the search text. 

The options you set are saved for each project. For more information on projects, see 

Working with projects (page 15). 

Schema Compare for Oracle project options 

The project options you can set are described below. 

Setting project options 
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Include deployment script header 

Includes a comment header at the top of deployment scripts. The header includes:  

 the date and time the script was created 

 the Schema Compare for Oracle build number used to create the script 

Force column order 

If deployment requires that additional columns are inserted into the middle of a table, 

this option forces a rebuild of the table so that column order is preserved following 

deployment.  

A table is rebuilt in four steps: 

1. A new table is created. 

2. Data from the original table is copied into the new table. 

3. The original table is dropped. 

4. The new table is renamed as the original table. 

Ignore slow dependencies 

Ignores certain dependencies that affect comparison performance when comparing 

databases. The following dependencies are ignored: 

 type objects in your schema that are referenced by an object in another user's 

schema 

 REF constraints in your schema that reference, or are referenced by, objects in 
another user's schema 

Note that if this option is not selected, all dependencies will be read, and comparisons 

may be slow. 

Ignore white space 

Ignores white space (newlines, tabs, spaces, and so on) in object SQL creation scripts 

when comparing databases.  

Note that white space will not be ignored when the databases are deployed. 

Ignore case differences 

Ignores case differences in object SQL creation scripts when comparing databases. For 

example, if you set this option, MYTABLE and mytable are not considered different table 

names. 

Note that case differences in strings and double quoted identifiers are not ignored. Case 

differences will not be ignored when the databases are deployed. 
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Ignore double quotes 

Ignores double quotation marks around identifiers when comparing databases. 

Note that double quotation marks will not be ignored when the databases are deployed. 

Ignore comments in PL/SQL blocks 

Ignores comments in PL/SQL blocks when comparing databases. 

Note that comments will not be ignored when the objects are deployed. 

Ignore constraint names 

Ignores the names of foreign keys, primary keys, and default, unique, and check 

constraints when comparing databases.  

Note that the constraint names will not be ignored when the databases are deployed. 

Ignore storage 

Ignores storage properties (physical properties and partitioning clauses) on tables when 

comparing and deploying databases. 

Note that table organization (heap-organized or index-organized) will not be ignored. 

Ignore sequence current value 

Ignores the current value of sequences when comparing and deploying databases. 

If this option is set and you deploy a sequence, the current value of the target sequence 

is retained. Note that if the current value of the target sequence is not within the 

MINVALUE and MAXVALUE limits of the source sequence, the current value will be reset 

to a default value. 

If this option is not set and you deploy a sequence, the current value of the source 

sequence is used as the current value for the target sequence. 

Default options 

To save your option settings as the default options for all new projects, click Save as My 

Defaults. To revert to your default settings after making changes, click My Defaults. 

To reset all the options to their original settings, click Red Gate Defaults. The Red Gate 

default options are as follows: 
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 Include deployment script header 

 Ignore slow dependencies 

 Ignore white space 

 Ignore case differences 

 Ignore double quotes 

 Ignore comments 

 Ignore constraint names 

 Ignore storage 

 Ignore sequence current value 
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When you have compared the data sources, Schema Compare for Oracle displays the 

comparison results. The Results pane displays all the objects you can select for 

deployment (page 37): 

 

You can define which objects are displayed by setting up a filter. You can also view the 

differences in the objects' creation scripts in the SQL Differences pane (page 34): 

 

To compare the data sources again using the same project configuration, and update the 

comparison results, click  Refresh. 

Viewing the comparison results 
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Object groups 

Objects in the results are displayed in groups. You can select how objects are grouped 

using the Group By box: 

 

You can group objects by: 

 Type of difference 

In the Results pane, when objects are grouped by Type of difference, the Type 

column indicates the difference: 

 
objects that exist in both data sources but are different 

 
objects that exist only in the Source  

 
objects that exist only in the Target  

 
objects that exist in both data sources and are identical 

Type of difference is the default grouping. 

 Type of object 

In the Results pane, when objects are grouped by Type of object, the Type column 

indicates the type of object: 

 Tables  Views 

 Procedures  Functions 

 Indexes  Types 

 
Triggers  Synonyms 

 Sequences  Packages 

The Owner column displays the owner, or schema, of the object. 

Note that this column is shown only when more than one schema in the database is 

compared. 
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 No groups 

All objects are listed individually; they are not displayed in groups. 

To view the individual objects within a group, click , or click the group heading bar: 

 
 

Using the filter 

You can specify which objects are included in, or excluded from, the results, by using the 

Filter pane. 

To display the Filter pane, click Filter Setup:  

 

The default filter is All objects included, which includes all objects in the Results pane. 
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To exclude an object type from the results, clear its check box. If you only want one type 

of object to be displayed in the results, first clear the All object types included check box, 

and then select the check box for that object type. 

Note that if you select an object for deployment and then set up a filter that excludes that 

object type, the object is not included in the deployment. Only selected objects that are 

shown in the comparison results are included.  

For example, if you select TableA for deployment, and then set up a filter to exclude all 

tables, no tables are shown. If you subsequently remove the filter, TableA is displayed 

and remains selected for deployment. 
 

Finding an object 

You can also use the Find box to assist you with your selection. 

To locate objects, in the Find box, type the search text. To select a recent search, click 

the Find arrow button   

As you type, objects are grouped in the upper pane by whether they match or do not 

match what you type. 

 

Schema Compare for Oracle searches object names and owners (schemas). 

Note that the search is not case-sensitive. 

To clear the Find box, click the  button. 

Note that if an object matches the term in the Find box, and is excluded by a filter, it is 

not displayed in the results. 
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When you are reviewing the comparison results (page 30), a side-by-side listing of 

differences in the creation SQL script for an object is displayed in the lower (SQL 

Differences) pane. To display the SQL Differences pane, click an object in the upper 

(Results) pane. 

 

You can adjust the height of the SQL Differences pane by dragging it up or down, or by 

using the  buttons to move the pane to a pre-set height. 

Click  to open the SQL Differences pane in a separate window. If you are working with 

multiple monitors, it can be useful to move this window to another monitor. Click  

again to re-dock the window.  

If you close the SQL differences pane, click an object in the Results pane to display it 

again. 

Viewing differences 

Lines that contain differences are displayed with a shaded background; text within a line 

that is different is displayed with a darker shaded background.  

The central column shows the type of difference: 

 there are differences in the group of SQL statements 

 

 

this line of SQL will be added if you deploy this object (the 

direction of the arrow indicates the database that will be updated) 

 this line of SQL will be removed if you deploy this object 

There is no icon if the two lines are identical. 

Use  Next and  Previous to go to lines that contain a difference. Alternatively, use 

Alt + Up Arrow and Alt + Down Arrow. 

Viewing the SQL differences 
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The Line Differences bar 

The Line Differences bar displays the selected line of the SQL creation script in both data 

sources one on top of the other. This is especially useful when the lines are too long to 

view all the text. 

To display the Line Differences bar, click  and then click Line Differences.  

  

Scroll bar 

Colored blocks in the left scroll bar indicate the location in the script of lines that are 

different. 

   a line of SQL that exists only in the object script on the left 

   a line of SQL that exists only in the object script on the right 

   a line of SQL that exists in both object scripts, but is different 

Searching and copying the creation script 

To search the SQL statements, right-click in the relevant box, and click Find. 

To repeat a search in the other data source, click either Find in target or Find in 

source. 

The search is not case-sensitive. 
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When you have run a comparison, you can create a report of the results. 

To create a report: 

1. On the Tools menu, click Create Report. 

The Create Report dialog box is displayed: 

 

2. In the Format box, select your required output format. You can create a report in one 

of three formats: 

 Simple HTML 

 XML 

 CSV 

3. Specify a name and location for the report. 

4. To include only objects with differences in the report, under Include, select Objects 

with differences. 

To include all the objects that you have selected for deployment (page 37), select 

Objects selected for deployment. 

Additionally, you can select the Also include identical objects check box to include 

identical objects in the report. 

5. Click Create Report. 
 

Creating a report 
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When you have reviewed the comparison results (page 30), you can select the objects 

you want to deployment. 

By default, no objects are selected for deployment. You select objects to deploy using the 

central check boxes in the results pane: 

 

To select all the objects in a group for deployment, select the check box on the grouping 

bar for that group; alternatively, you can right-click within the group and then click 

Include All Objects in this Group.  

To exclude all the objects in a group from the deployment, clear the check box on the 

grouping bar for that group; alternatively, you can right-click the group and then click 

Exclude All Objects in this Group. 

If only some objects in a group are selected for deployment, the check box on the 

grouping bar shows a mixed state: 

  

Setting up the deployment 
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To include or exclude all objects that are displayed in the results pane, use the top-level 

check box in the central column: 

 

You can also filter the object types (/supportcenter/Content.aspx?p=Schema Compare for 

Oracle&amp;c=Schema_Compare_for_Oracle/help/1.0/sco_viewing_comparison_results.

htm&amp;toc=Schema_Compare_for_Oracle/help/1.0/toc1098219.htm#o9487) and use 

the Find box (/supportcenter/Content.aspx?p=Schema Compare for 

Oracle&amp;c=Schema_Compare_for_Oracle/help/1.0/sco_viewing_comparison_results.

htm&amp;toc=Schema_Compare_for_Oracle/help/1.0/toc1098219.htm#o9505) to assist 

you with your object selections. 

Object selections are remembered when you save a project. Note that if you save a 

project with a grouping set to include all objects in that group, the next time you use the 

project all objects in that group are selected for deployment, even if they did not exist 

when the project was saved. 

When you have selected the objects you want to deploy, click  Deployment Wizard 

to start the Deployment wizard (page 40). 

Example: Selecting only views 

To select only views for deployment: 

1. In the central column of the results, clear the top-level check box if it is selected. 

2. In the Filter pane, ensure that the All object types included check box is selected.  

3. From the Group by box, select Type of object. 

The objects are now grouped by their object type.  

4. On the grouping bar for views, select the check box to include all of the objects in 

this group for deployment. 

/supportcenter/Content.aspx?p=Schema%20Compare%20for%20Oracle&amp;c=Schema_Compare_for_Oracle/help/1.0/sco_viewing_comparison_results.htm&amp;toc=Schema_Compare_for_Oracle/help/1.0/toc1098219.htm#o9487
/supportcenter/Content.aspx?p=Schema%20Compare%20for%20Oracle&amp;c=Schema_Compare_for_Oracle/help/1.0/sco_viewing_comparison_results.htm&amp;toc=Schema_Compare_for_Oracle/help/1.0/toc1098219.htm#o9487
/supportcenter/Content.aspx?p=Schema%20Compare%20for%20Oracle&amp;c=Schema_Compare_for_Oracle/help/1.0/sco_viewing_comparison_results.htm&amp;toc=Schema_Compare_for_Oracle/help/1.0/toc1098219.htm#o9487
/supportcenter/Content.aspx?p=Schema%20Compare%20for%20Oracle&amp;c=Schema_Compare_for_Oracle/help/1.0/sco_viewing_comparison_results.htm&amp;toc=Schema_Compare_for_Oracle/help/1.0/toc1098219.htm#o9505
/supportcenter/Content.aspx?p=Schema%20Compare%20for%20Oracle&amp;c=Schema_Compare_for_Oracle/help/1.0/sco_viewing_comparison_results.htm&amp;toc=Schema_Compare_for_Oracle/help/1.0/toc1098219.htm#o9505
/supportcenter/Content.aspx?p=Schema%20Compare%20for%20Oracle&amp;c=Schema_Compare_for_Oracle/help/1.0/sco_viewing_comparison_results.htm&amp;toc=Schema_Compare_for_Oracle/help/1.0/toc1098219.htm#o9505
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Example: Selecting objects that exist only in the source 

To select all objects that exist only in the source database for deployment: 

1. In the central column of the results, clear the top-level check box if it is selected. 

2. In the Filter pane, ensure that the All object types included check box is selected.  

3. From the Group by box, select Type of difference if it is not already selected.  

The objects are now grouped by whether they are different, identical, or present in 

only one of the data sources.  

4. On the grouping bar for objects that exist only in source database name, select 

the check box to include all of the objects in this group for deployment. 

Example: Selecting only tables that exist in both databases but are 
different 

To select only tables that exist in both databases but are different for deployment: 

1. In the central column of the results, clear the top-level check box if it is selected. 

2. In the Filter pane, clear the All object types included check box, and then select the 

Table check box. 

Only tables are now displayed in the results. 

3. From the Group by box, select Type of difference if it is not already selected. 

The objects are now grouped by whether they are different, identical, or present in 

only one of the data sources.  

4. On the grouping bar for objects that exist in both but are different, select the 

check box to include all of the tables in this group for deployment. 
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When you have selected the objects (page 37) that you want to synchronize, you can use 

the Synchronization wizard to create the SQL script that will synchronize the databases. 

To start the Synchronization wizard, click  Synchronization Wizard. 

There are four possible steps in the wizard: 

1. Choose synchronization method (page 40). 

Choose to create and save a synchronization script, or synchronize using Schema 

Compare for Oracle. 

2. Review dependencies (page 43). 

View a list of any objects that reference, or are referenced by, the objects you have 

selected to synchronize. You can choose to synchronize these affected objects. 

3. Configure script (page 46). 

View a list of issues that affect the synchronization, and select actions to update the 

synchronization script. If there are no synchronization issues, this step is not shown in 

the wizard. 

4. Review script (page 48). 

View the synchronization script, review a summary of the synchronization actions, and 

see information about any warnings. 
 

1. Choose synchronization method 

On the first page of the Synchronization wizard you can choose to create and save a 

synchronization script, or synchronize using Schema Compare for Oracle. 

Using the Synchronization wizard 
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Synchronize using Schema Compare for Oracle 

If you want to create a synchronization script that you can run at the end of the wizard, 

in the left-hand pane, select Synchronize using Schema Compare for Oracle: 

 

Note that if the target data source is a snapshot, the option to synchronize using Schema 

Compare for Oracle is not available. 

When a snapshot is the source data source, and a database is the target, synchronization 

updates the database to synchronize it with the snapshot. 

When a snapshot is the target data source, synchronization creates a script to update the 

database from which the snapshot was created. Note that snapshots cannot be modified 

directly. 

You can create a snapshot of the target database schemas before synchronization. The 

snapshot preserves the state of the target before the synchronization, and later can be 

used as a source, to restore the target to that state.  
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Create a synchronization script 

If you want to create a synchronization script to open in your SQL editor at the end of the 

wizard, in the left-hand pane, select Create synchronization script: 

 

To change the SQL editor used to open the script, click Change. The Application Options 

dialog box is displayed, and you can specify a default editor: 

 

Note that if you use Oracle SQL Developer, the encoding settings in Schema Compare for 

Oracle and Oracle SQL Developer must be compatible. For more information, see 

Selecting encoding settings (page 49). 
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2. Review dependencies 

The Review dependencies page lists any objects that reference, or are referenced by, 

the objects you have selected to deploy: 

 

All the objects you selected for deployment are listed in the left-hand pane. If any of 

these objects reference, or are referenced by, objects that you included in the 

comparison but did not select for deployment, the objects you did not select are listed in 

the right-hand pane. 

For example, if a view references a table, and you did not select the table for 

deployment, the table is listed in the right-hand pane. 

Additionally, ghost objects may be listed in the right-hand pane. For more information, 

see Ghost objects (page 44). 
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You can view the SQL creation script (page 34) for any object in the right-hand pane by 

clicking its object name in the Objects affected column. The creation script for the 

selected object in both data sources is displayed, and any differences are highlighted: 

 

By default, Schema Compare for Oracle deploys all affected objects.  

We recommended you deploy all affected objects. If you do not, the deployment script 

may fail, or produce unexpected results. 

To exclude an affected object from deployment, clear the Deploy all affected objects 

check box, and then clear the check box for the object. 
 

Ghost objects 

A ghost object is an object that was not included in the comparison, but references, or is 

referenced by, an object that was included. 

For example, if a table in the comparison references a stored procedure in a schema that 

you did not include for comparison, the stored procedure is a ghost object. 

Schema Compare for Oracle includes ghost objects in the comparison automatically. This 

can be useful, for example, if you want to deploy a table that references a stored 

procedure, but forget to include the stored procedure in the comparison. 

Schema Compare for Oracle lists any ghost objects in the Review dependencies (page 43) 

page of the Deployment Wizard. 

We strongly recommend you deploy all ghost objects. If you do not, the deployment 

script may fail, or produce unexpected results. 

Note that: 
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 ghost objects are not displayed in the comparison results 

 if you compare schemas with objects which reference, or are referenced by many 

ghost objects, the comparison may be slow 

 if you save a snapshot of the source or target database, ghost objects may be 
included in the snapshot 

Example: Deploying a table with dependencies 

The following example demonstrates how Schema Compare for Oracle includes ghost 

objects in the deployment. 

In the example, you have already compared SchemaA in the Dev database to the same 

schema in the Test database: 

 

TableA is a table in SchemaA in Dev. You have added a new column to TableA, which you 

want to deploy to Test: 

 

The new column references a new data type mytype, which you have created in another 

schema in Dev, SchemaB: 

 

If you select TableA for deployment, and you run the Deployment Wizard, mytype 

appears in the list affected objects on the Review dependencies page.  

To deploy mytype, ensure its check box is selected, and run the deployment script.  

To exclude mytype from the deployment, clear the Deploy all affected objects check 

box, and then clear the check box for mytype before you deploy. 
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3. Configure script 

If there are any issues with the deployment that might cause the script to fail, the 

Configure script page is added to the Deployment Wizard. 

This page lists any issues that affect the deployment, and allows you to select actions to 

update the deployment script. 

There are two types of issue: 

 No value specified for a NOT NULL column 

 Data type must be converted 

No value specified for a NOT NULL column 

 

If no default value is specified for a column with a NOT NULL constraint, you can select 

one of the following actions: 

 Allow NULL value 

The column is altered to allow NULL values.   

 Specify custom value 

A value you specify is used as the default for the column. To specify a value, in the 

Value column for the issue, type any constant that is valid for a default expression, or 

any valid SQL expression: 
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 Ignore issue 

If you select this action and run the deployment script, the deployment will fail. You 

are strongly recommended to review and edit the deployment script before running it 

on your target database. 

Data type must be converted 

 

 If the data type for a column must be converted in the deployment, you can select one 

of the following actions: 

 Specify custom value 

A value you specify is used to convert the data type for the column. To specify a 

value, in the Value column for the issue, type any valid SQL expression for an 

INSERT INTO select statement. 

 Ignore issue 

If you select this action and run the deployment script, the deployment will fail. You 

are strongly recommended to review and edit the deployment script before running it 

on your target database. 

When you have selected an action for each issue, click Next to review the deployment 

script. 
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4. Review script 

The final page of the wizard displays information about the synchronization: 

 

There are three tabs: 

 Synchronization script shows the script to synchronize the data sources. 

You can search the script, save it, or copy it to the clipboard. 

 Summary shows a synopsis of the actions in the synchronization script. 

You can view the summary grouped by the objects affected, by the type of 

modification, or by the order in which the script modifies the target. 

 Warnings shows a list of any warnings about unexpected behavior that may occur 

when you synchronize the databases. 

When you have reviewed the script, to perform the synchronization click Synchronize 

Now. 
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To view the deployment script with correct formatting in Oracle SQL Developer, the 

encoding settings in Schema Compare for Oracle and Oracle SQL Developer must be 

compatible. 

The following is a recommended list of compatible settings: 

 Schema Compare for Oracle Oracle SQL Developer 

 UTF-8, UTF-8 with preamble UTF-8, UTF8 

 UTF-16 UTF-16, UTF16, UTF_16 

 ASCII ASCII, Windows-1252 

To select an encoding setting in Schema Compare for Oracle:  

1. On the Tools menu, click Application Options. 

2. Select the General tab.  

3. Under Deployment scripts, in the Encoding box, select the encoding setting you 

want to use. 

To select an encoding setting in Oracle SQL Developer: 

1. On the Tools menu, click Preferences. 

2. Under Environment, in the Encoding box, select the encoding setting you want to 

use. 
 

Selecting encoding settings 
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On the Review script page of the Deployment Wizard (page 40), you can click the 

Warnings tab to view information about inefficiencies in the deployment script, or 

reasons the script may fail. 

 

When warnings are displayed, we strongly recommended you review the deployment 

script and make any required changes before running it on your target database. 

The most common warnings that Schema Compare for Oracle may display are listed 

below. 

Table will be rebuilt 

Deployment will rebuild a table. The table is rebuilt in four steps: 

1. A new table is created. 

2. Data from the original table is copied into the new table. 

3. The original table is dropped. 

4. The new table is renamed as the original table. 

A table is rebuilt when deployment requires making changes that cannot be specified in 

an ALTER TABLE statement. 

Warnings 
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Columns will be dropped 

When a table is rebuilt, if a column in the target table does not have a matching column 

in the source table, deployment will drop the target column. Data in the target column 

will be lost. 

Data will be truncated 

Deployment will reduce the width of a column in a table. If there is data in the column, 

the deployment script will fail. 

No value specified for NOT NULL column 

If no default value is specified for a NOT NULL column in a table, the deployment script 

will fail. 

To specify a default value:  

1. Click Back to display the Configure script 

(/supportcenter/Content.aspx?p=Schema%20Compare%20for%20Oracle&amp;c=Sch

ema_Compare_for_Oracle/help/1.0/sco_using_the_synchronization_wizard.htm&amp;

toc=Schema_Compare_for_Oracle/help/1.0/toc1098225.htm#o9528) page. 

2. In the Value column for the issue, enter the value you require. 

Default value will be added 

Deployment will set a value specified on the Configure script 

(/supportcenter/Content.aspx?p=Schema%20Compare%20for%20Oracle&amp;c=Schem

a_Compare_for_Oracle/help/1.0/sco_using_the_synchronization_wizard.htm&amp;toc=S

chema_Compare_for_Oracle/help/1.0/toc1098225.htm#o9528) page as the new default 

for a column. 

To specify a different default value:  

1. Click Back to display the Configure script page. 

2. In the Value column for the issue, enter the value you require. 

Data type cannot be converted 

Deployment requires that a data type is converted to an incompatible data type. For 

example, Schema Compare for Oracle cannot convert a BFILE data type to a NUMBER 

data type. If you run the deployment script, data in the target column will be lost. 

Type object cannot be deployed 

Deploying type objects is not supported. If the type object is not referenced by another 

object, it will not be deployed. If the type object you want to deploy is referenced by 

another object, the deployment script will fail. 

/supportcenter/Content.aspx?p=Schema%20Compare%20for%20Oracle&amp;c=Schema_Compare_for_Oracle/help/1.0/sco_using_the_synchronization_wizard.htm&amp;toc=Schema_Compare_for_Oracle/help/1.0/toc1098225.htm#o9528
/supportcenter/Content.aspx?p=Schema%20Compare%20for%20Oracle&amp;c=Schema_Compare_for_Oracle/help/1.0/sco_using_the_synchronization_wizard.htm&amp;toc=Schema_Compare_for_Oracle/help/1.0/toc1098225.htm#o9528
/supportcenter/Content.aspx?p=Schema%20Compare%20for%20Oracle&amp;c=Schema_Compare_for_Oracle/help/1.0/sco_using_the_synchronization_wizard.htm&amp;toc=Schema_Compare_for_Oracle/help/1.0/toc1098225.htm#o9528
/supportcenter/Content.aspx?p=Schema%20Compare%20for%20Oracle&amp;c=Schema_Compare_for_Oracle/help/1.0/sco_using_the_synchronization_wizard.htm&amp;toc=Schema_Compare_for_Oracle/help/1.0/toc1098225.htm#o9528
/supportcenter/Content.aspx?p=Schema%20Compare%20for%20Oracle&amp;c=Schema_Compare_for_Oracle/help/1.0/sco_using_the_synchronization_wizard.htm&amp;toc=Schema_Compare_for_Oracle/help/1.0/toc1098225.htm#o9528
/supportcenter/Content.aspx?p=Schema%20Compare%20for%20Oracle&amp;c=Schema_Compare_for_Oracle/help/1.0/sco_using_the_synchronization_wizard.htm&amp;toc=Schema_Compare_for_Oracle/help/1.0/toc1098225.htm#o9528
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Sequence current value will be lost 

The current value of the target sequence will be lost because it is not within the 

MINVALUE and MAXVALUE limits of the source sequence. The current value will be reset 

to a default value. 

Partitioning will change 

Deployment will make changes to the partitioning of a table. The table will be rebuilt.  

You are strongly recommended to review and make any changes to the table rebuild 

section of the deployment script before running it on your target database. 

System partitioning cannot be changed 

Making changes to the partitioning of a system partitioned table is not supported. If you 

run the deployment script, the table will not be deployed. 

REF constraints cannot be deployed 

Deploying REF constraints is not supported. If you run the deployment script without 

making any changes, it may produce unexpected results.  

 
 

 


